Microsoft PowerPoint 2007

Assoc. Prof. Pannipa Phaiboonnimit ——————

Adapted for English Section by Kittipitch Kuptavanich

and Prakarn Unachak

204100 MS PowerPoint 1

Microsoft PowerPoint

*MS PowerPoint is an application software, is a
program to represent work

*MS PowerPoint can create/ build
 Presentation Slide
® Audience handout (handout document to audiences)
B Speaker’s Note (script for a speaker)

2 Qutline page (a page of outline to be presented)
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Outline

¢ Screen Layout ¢ Slide Show

®Beginning with Home  ® Animation
Tab * Printing

¢ Formatting Objects ¢ Tips on Creating a

¢ Inserting Objects Presentation

* Design ¢ An Example

[ —
MS PowerPoint 2007: screen Layout

Manage screen bar
)

Slides and
layouts
tabs

Current
slide

& C

View slide ‘ ‘Zoomslide ‘
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Screen Layout — Quick Access

Toolbar

¢ Contains often-used commands.

" You can press the downward arrow to customize the

toolbar.

(o H9- - H"‘_

L Home | Insery Customize Quick Access Toolbar
iy * New

_j = Calibri Open

EE| =

Paste > B I U V| save
Clipboard il

Musirle Drind

T
Screen Layout — The Ribbon (2)

® Extra tabs can appear when you select an object

Screen Layout — The Ribbon (1)

pp204100-thai - Microsoft PowerPoint

Design Animations Slide Show Review View

\:‘ =] Layout T = & ""EJ o E‘ ||f} Text Ditection
23 Copy BejReset —— ——— (5] Atign Text
B S Forinat Paimter || spee 30 Delete [BlF e & 8- aac][ A ] [= 2 Convert to SmartArt
Clipbaard £ Slides Font = Paragraph g

Home: Clipboard, Slides, Fonts, Paragraph, Drawing, Editing

Insert: Tables, Illustrations, Links, Text, Media Clips

Design: Page Setup, Themes, Background

Animations: Preview, Animation, Transition to this slide

Slide Show: Start Slide Show, Setup, Monitor

Review: Proofing, Comments, Protect

View: Presentation Views, Show/Hide, Zoom, Color/Grayscale, Window, Macros
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Screen Layout — MS Office Button

® Open, Save, Print, Send
*New Presentation :

% You can start a new presentation from

204100 MS PowerPoint
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Templates
* A PowerPoint template is a pattern or blueprint of a

slide or group of slides

Lo
Click to add notes
204100 MS PowerPoint
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Themes

®To give your presentations a designer-quality look
— a look that includes one or more slide layouts
with coordinating colors, a matching background,

fonts, and effects, you'll want to apply a theme.
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Templates: Examples
Agendas Award certificates Brochures
Budgets Business cards Calendars
Content slides Contracts Databases
Design slides Diagrams Envelopes
Expense reports Fax sheets Flyers
Forms Gift certificates Greeting cards
Inventories Invitations Invoices
Labels Letters Lists
Memos Minutes Newsletters
Plans Planners Postcards
Purchase orders Receipts Reports
Resumes Schedules Schedules
Statements Stationary, . cpoin Time sheets o

Themes

weltable Templates and Themes
@ Home + Them
Aa ﬁA AA | k- 1
. R r—
— e som pothecary aapec

- E An AA Aal
M mssmem | (=mmmmm | [sssees -

— el

Couture Eremental o Essertial
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Blank Presentation

3 ‘ Blank Presentation

Click to add title

Click to add subtitle

nnnnnnnnnn

2

=3
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Different views in PowerPoint

Oy H2-V )= Presentation1 - M
~ Home Insert Design Review
0 |0 L) O im0 ]

Normal| Slide MNotes Slide Slide Handout Notes Zoony
Sorter Page Show  Master Mastes Master

!Pusen!atlon v-ml

Animations Slide Show

Message Bar Direction =
Show/Hide

¢ Creating or editing
® Normal view
© Slide Sorter view
B Notes Page view

B Master views
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Open and save

¢ Open
> MS Office Button = Open —> Select File
¢ Save

> MS Office Button 9 Save as 9 LRanN version
@’ Type in File Name - 0K
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Adding New Slide

® Add new slide : Home tap — New slide

~ Insert Desig
U | 21 Layout ~
B Reset

Paste

<3
Hew,
| J | sidd)d Delete
jCebond =) L2000 |

®  Or Press Ctrl-M
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Different views in PowerPoint

Lng H2-0 = Presentation1 - M
~ Home Insert Design Animations Stide Show Review
= o o] = [ (= Ruler
== |_” o= ] : 4] Q

4| = Gridlines

INo: Slide Notes Slide Slide Handout Notes View Zoon

Sorter Page Show  Master Master Master Message Bar Direction -
[Frezeniation views] Show/Hide

¢ Normal

o For editing and creating new slides
¢ Slide Sorter

9 See the ordering of slides

® Note Page

2 Add notes to the slides

[ o | |
* Slide Show =R

o Show the presentation

)
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To Close

Note Master

=7 Notes Master | Home

e E

by v Fonts
Page NotesPage _Slide = | emes
Setup Orientation ~ Orientation - | V! F¢ -

Page Setup Edit Theme

e
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Slide Master

Menus Home Insert Dulgn Transitions Animations Slide Show REI’IEW
Q slide Sorter J slide Master |:| Ruler q =
. Handout Master E| Gridlines

. Hates Page

%.

Hormal Zoom Fitto Color/Grayscale Window | Macros
[ Reading View | [5] Notes Master [ Guides Window - -
Presentation Vlews | Master Views Show | Zoom | | | Macros |
=

¢ Used for:
o Make Changes to All Slides
2 Adding and Changing Layout

e — T
Home Tab

¢ Slide Layout
¢ Change Font Typeface and Size

¢ Alignment & Text Direction
¢ Drawing

¢ Editing

204100 MS PowerPoint
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=] Layout -

Slide Layout

[ = ==

urban

Title Slide

Title and Content

Section Header

Two Content

Comparison

Title Only

Blank

Cantent with
Caption

Picture with
Caption

¢ On a slide, Define
2 Containers
o Positioning

2 Format
¢ Can add your own on Slide

Master

21

B L U e 8§ - Aav|| Al

Change Text Color

MR NI

heme Colors

Standard Colors
L ] | fEEEEN
Recent Colars

) | More Colors...

Font

204100 MS PowerPoint
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Change Font Typeface and Size

Calibri D 1 -|[A

Theme Fonts
T Calibri (Headings)
1 Calibri tBody)

Recently Used Fonts
¢ Arno Pro Smbd
All Fonts
() Adoba Cadon Pro

0 Adobe Caslon Pro Bold
© Adobe Garamond Pro
' Adobe Garamond Pro Bold

] b
I F
B
£

00K PREGENTATION INCLUDE:

Shape

ication of lar

= Mome t3b and then cick o dropdown

ign Animations  sglide Show Revi

T
CalibrBody—fs (11~ \A‘ ,{|
|B 7 U abe 8 - Aa-||A -

Font ]

T fgency BB
i ALGERIAN | ||
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Alignment
*Home —> alignment
= 5 13-
o Align Left _ ——
9 = =] =
o Center Paragraph T |
© Align Right
2 Justify
204100 MS PowerPoint 24
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Indentation & Paragraphs

Text Direction

® Increase or Decrease Indentation to Lines of Text

Change the direction of text

Select the text, then go to Home Tab —> Text Direction
= -|[z= &=|[3=- | 8-

= = §| %:
Paragraph

25
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Selecting Objects

Formatting Objects
¢ Click on the object you want to select

* Depending of type of objects, additional tabs will

® Change the Appearance of & Shape Fill ~
appear

B_’ Shape Outline =
Objects (text box, shapes, etc.)

S | Shape Effects =
®Can change:

2 Objects’ Color (Shape Fill)

® Objects’ Outline

? Adding Effects to Objects

27
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Shape Fill

¢ Adding/Changing Fill Color of an
Object
¢ Select the object, then go to

® Home Tab —> Shape Fill

4 shape Fill-=

ﬁ% Find

Theme Colors
H AEENNNN

Standard Colors
HE fEEEEN
Recent Colors

|| noFn

i) | More Fill Colors...

Eﬁ Picture...

[ Gradient 3
=

Texture (3

29

Shape Effect

¢ Adding/Changing Effects to an
Object, such as:
B Shadow
" Glow

¢ Select the object, then go to

® Home Tab —> Shape Effects

. Ak shape Fill ~
=Z shape Outline ~ al
-l Shape Effects = L&
] ! Preset »
| l Shadow 3
| | mefiection >
Glow >

31
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Shape Outline

* Adding/Changing Outline of an o oe o] o rooe
Object n:mc:h:----n
" Type of line |IIIIW||||
o Color .:E:T;ET'; T
2 Weight (width) T

* Select the object, then go to El ﬁ:o ’
" Home Tab —> Shape Outline ; = :

30
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Quick Style

® Adding Styles (fill + outline + effects) to an Object quickly.
® Select the object, then go to
® Home Tab —> Quick Styles

[/ osssseoo

o« mspessen| | |

N T e
T T i
- - - -
Other Theme Fills — | 32
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Arrange

¢ Changing the Order of Objects

2 Which one appear in front/in the back of others
® You can also group objects
© Select the object(s), then go to

® Home Tab —> Arrange

2 Then select the ordering/grouping

g

Order Objects
‘E& Bring to Front
2% send to Back
% Bring Forward
|-_(:] Send Backward

Group Objects

Position Objects
1= Align 4
S Rotate 3

% Selection Pane...

Insert Table (1)

® Insert Tab —> Table

B Select dimensions of cells then press Enter of
Left Click
¢ Table Tools Tabs will appear
2 Design

B Layout

= | HE g 1
bl HE B
| Table ||| Picture Clip  Photo Sh:

At Album ~
Insert Table

I
I
I
I
I
I
I
I

[ Insert Table...

4 DrawTable

G Excel Spreadsheet

35

e — T
The Insert Tab

Insert Tab
/C!n H292-0 )= Presentationl - Microsoft PowerPoint

= N oy
O -8y

Table Picture  Clip  Photo Shapes SmartArt Chart Hypetink Action Text Header WordArt Date Slide Symbol Object
= At Album=  ~ Box~ & Footer - & Time Number

| Tables [istrations | Links | |
°*Table °Photo Album ® Chart

Animations Shide Show Rewi

SR 3 4 3 GE Qe

° Picture ¢ Hyperlink

*Clip Art

* Shapes

® Smart Art ® Action

More details @
204100 MS PowerPoint 4
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Insert Table (2)

® Design Tab is for changing the look (border, color)

N A TS
&

Home  Insert  Design  Amimations  SlideShow  Review  View | Design  layout

———— ———— R a A 3 @ E
e < See| o H Borders - & || -
= - [—— _— Quick Draw  Eraser
T DEtets v | Sylese A7 || gPenColary  Taple

Wordart Styles Draw Borders

Pp204100-thai - Microsoft PowerPoint Table Tools

W] HeaderRow [ First Column

[ TotalRow [ Last Column

] Banded Rows [ Banded Columns
Table Style Options Table Styles

¢ Layout Tab is for changing how cells/table are

positioned

@ H9-05 )+ PRR04100-tha - Microscft PoverPaint Tabe Toos
()

Home Iniert  Deiign  Anmations  SideShow  Review  View  Design | Lyjout

Rf E @ ﬂ EEE E E{ % 4] vegnt 041" 3 |G pistribute Rows

Selet View | Delte | Inset Inset Insert Insent | Meroe Solt | ) wigth 225
v Grdlines k4 Above Below Left Right Cells  Cells
Table Rows & Columns Meige Cell Size

2| Tyeringtofront * 12 Alig

2 |/| By sendto Back = [ cra
B, SelectionPane S Fote

Alignment Takle Size Arange

TG

e =
3 |t Distribute Columns =
Al ‘ Q‘Dwmmn'Mavg\ns' Lock Aspect Ratio

36
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Insert Picture

¢ Insert Tab — Picture Mﬁl
? Select the image you want

B Click Insert

® Format Tab (Picture Tools)

(a9~ 0 5~ )+ PP204100-thai - Microsoft PowerPoint Ficture Tools
()R LT
- Home Tnsert Design Animations Slide Show Review View ‘ Format 1

& Brightness = & Compress Pidures

OyRecolor g Reset Ficture
Adjust Piture Styles

2 Alter color, shapes, position, even which part will be shown

e N E— (P Picture Shape - | T Bringto Front ~ |2 Align ~ @ £1] et 225
O contrast = Eycrange picure | |l || | sl ; ‘ il u E - @ picture Border - | & send toBack » [ roup -

) picture Effects ~ | B Selection Pane S Rotate +

Crop =2 width: 5.

Amrange size

=

37

Insert Shapes
®Insert Tab —> Shapes vy

Shapes

@ Select the shape you want

B Then click-and-drag to draw it on the

slide

e @

IShapes|smartart Chart | Hyperiink Action

Recently Used Shapes
E\N\NO0OALL2ES
RTA ]

Recta
e e =]m])

Basic Shapes
EHOADOTACOOOO®
®GooOr Ly o0Ea
= [SISEAINIOIAN =A@}
(RSN G

Block Arrows

DEG OO H LML S
€ dwnRDD DM IN
RELede

Equation Shapes

f=R-=

Flowehart

Do /000G =0aY
ONON®D X ¢ AVED
QEO0

Stars and Banners

TP DO DEHBEE
padandiaibia i s{ASINA

Callouts,

Lines
SNNTLLR WUNG %
ngles

DO QD AAE A A 52

|

39

N Clip Art - x

Insert Clip Art
B

°Insert Tab — Clip Art

Art

-~

2 Clip Art panel will appear

B Use keywords to search for clip arts

* Type keywords under Search for:

* Click Go

<)

8] organize dips..
%2 clip art on Office Online

(&) Tips For finding clips

Insert SmartArt
* Premade combination of texts and shapes
*Insert Tab —> SmartArt sﬁ
® Select SmartArt
® Make changes as you’d like
B Type in Text
® Change Color and Layout

23/01/58
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[ErE——] |
Insert Chart i e 100 8 M|
* Graphical Representation of e ) b 40
Data (graph) : Mﬂ@@@
¢ Insert Tab — Chart g
@ Select Chart Type

SmartArt G o

o Rew

2 Type in Data on

NENE

Spreadsheet 7
o Adjust Details
“:”7"’ e e ¢ Design, Layout and =
UE EVE A | AAL AM A AAA Format Tabs will appear =
4 Category 1 Category > Category 3 Category 4 2

Insert Text Obiects Text Objects

Insert Tab
;./Ch H92-0 )¢ Presentationl - Microsoft PowerPoint Add text
=) Text
Home [ inset | Design  Animations  ShideShow  Review  View Box . . .
E = = = : click text box —> drawing text box — typing letter

{ > 8 1 t A E

D usmyaul @1 A 24 30Q4w .

Table Piture Clip Photo Shapes SmamtArt Chart = Hypedink Action  Tet Header WordAt Date Slide Symbol Object s Add word art
|| Tables = A Links st odadic, e i Cliick word art — sellect type —> typing letter

¢ Text Box £2 Add symbol

Symbol

“Z Click Symbol — select symbol — insert
“ Insert Tab — Text Box

B Click and Drag to position the text box

° When you select a shape or a text object, Format tab (Drawing Tools) will appear
. \d9- 0 pP204100-thai - Microsoft PowerPoint Drawing Taals
O (Da) B O 7
)
Type In the TeXt = Home Inset  Design  Animations  SlideShow  Review  View Format
ENSCIO0]H rzeanshape S shape Fil - A TetFil - G Bring to Front + |2 Align + ilhsr
ALLDE G- | 2 shapecutine A A A\ [ @ retoutine- || Bysenatossce» B croup-
E -~ She
G ) oy = Ereoor = O shape Effects * S0 5 A restetteds || By SelecionPane S Rotate + | 2 12
3 Insert Shapes Shape Styles i WordArt Styles 5 Amange Size. By
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Adding Header and Footer

® Insert Tab —> Header and Footer

[plseidsy auid Fugisy

[X]

7 -x

Slide | Notes and Handouts |
@ Include on slide apply to Al
oate > [JDate and tine: :
e Update automatically fipply
Text
Language: Calendar bype:
s [Thai | [Thaibuddnist ]
Humber Fixed
B
o] slide pumber
i =[] Eooter
B |
=) [ |
Header
& Faoter [C]pan't show an titke slide

45

Design Tab

*Page Setup & Slide Orientation

Qrientation
i sides

) portrait

(%) Landscape

Motes, handouts & outling

(&) Portrait

Nurnber slides from; () Landscape

- |

¢ Background

204100 MS PowerPoint

F S
=1 | na
Slide (1] ——
Orientation =/ ||
= Partrait

Landscape

47
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Links

¢ Hyperlink ?”
B Create Lihk to web page, picture, e-mail, other slide
o Select object — Insert tab —> Hyperlink

¢ Action
@ Add the action to the object selected what will be

happen when click or moving mouse cursor over it.

® Example.
o Select object — Insert tab —> Action

46

e T
Them

Sidesou Reiien

_

oy | orson

ver | roms
-
s

°* Theme

@ Design — select theme

*To apply new colors to a theme: -
. | msl ]| er“a'w‘m
o Click the Colors drop down arrow ‘ o

EORENEEE opuint
NOERROON ond

EONEDCEE ongn
EOREEEEE Fper
W ROEEEE ot

8 Choose a color set or click Create

New Theme Colors

L Wl Technic
L8 N Trek

L8l N e
EONEEEEE e -

TITLE—p- goeentonecoms- "

23/01/58
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Background

Background

Design — Background styles

| |
- T
=

i Background Styles ~ |

"' Hide Background Graphics

‘Background £ ‘

<3| Farmat Backgraund...
3| geset siide Backgro

49
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Slide Slow (cont.)

¢ Custom Slide Show
? Show chosen slides and ordering
® Set Up (default) Slide Show
B Show Type
B Screen
B Custom Order
¢ Hide (current) Slide
¢ Record Narration
¢ Rehearse Timing

204100 MS PowerPoint 51

e — T
Slide Show

vid 9 -0 PresentationS - Microsaft PawerPaint Drawin
|0y
= Home

Insert Design Animations Slide Show Review View Developer Add-Ins Acrobat Fon
| ~ £ R i Record Marmation (@) Resolution:
SIS S
| @ e R RN
From From Custom SetUp  Hide

(57 Rehearse Timings [#F) Show Presentation On:

Use Current Resolution =

| Beginning Current Shde | Siide Show= | ShdeSmow Shide ¥ Use Rehearsed Timings Use Presenter View
Start Slide Show Set Up Monitors
From From Custom

Beginning Current Slide | Slide Show =
Start Slide Show

204100 MS PowerPoint 50

Animations Tab

® Slide Transition
® Slide Animation

® Animation Preview

204100 MS PowerPoint 50

23/01/58

12



Slide Transition

| Animations | Slide Show Review Developer Add-Ins Acrobat

,& Transition Sound: | [Mo Sound] =
! - -! ’lﬂ Transition Speed Fast =

Transition to This Slide

B Slide transitions are the animation-like effects that
occur in Slide Show view when you move from one

slide to the next during an on-screen presentation.

204100 MS PowerPoint 53

Slide Animation

® Animation effects and sounds ® To Apply an Animation Effect
can add excitement to your © Select the object
presentations and help you ? Click the Animations tab on the
emphasize key points while you Ribbon

deliver the slide show o Click Custom Animation

o

Click Add Effect

B Choose the appropriate effect

55

Using Slide Transition

® Transition Effect
® Transition Sound
¢ Transition Speed

* Apply to All

204100 MS PowerPoint
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Custom Animation

¢ Effect Options
@ Effects
B Timing

® Ordering

204100 MS PowerPoint
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Animation Preview

°To preview the animation on a slide:

5 Click the Preview button on the Animations tab

@) a2~ )+
Gt |

Home Insert Design |

i @‘W No Animation ~
| Preview || 295 custom Animation

Preview | Animations

204100 MS PowerPoili&
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Printing Slides

Printing in Notes Pages

Outline View

Outline View of slides

Printed in Color pr
o

Slides printed in Notes Pages will display the DOiMake sure that Sides is selected in the At what: bar
headinctas o ik i HEdny Dltis 2 good idea to Scale side tofi paper
A Dichoose to print in colof, grayscale or pure black andwhte
2[E) Printing Handouts
D0ffice Buttan > Print
DiSelect Handouts: from the Aot what: section

These notes do not show on the screen during the
presentation

Pages
These are my notes for this slide. DSlides printed in Notes Pages wil display the speaker's notes for making the
presentation.

DThese notes do not show on the screen during the presentation
View

wayfor the spes)
while this slideis on the screen.

Printing in Outline
DOutine View shows the text only on the sides

Pages. These natesdo nat Coutine View are often used to summarce the presentation
D0uthine View printouts can be given out as handouts

The i
shaw on the screen during the presemation

204100 MS PowerPoint 59

Printing Slides

® Handouts

* Notes pages

* Presentation

Handouts for note taking =~

® Qutline view = =

204100 MS PowerPoint

58

Steps to Create a Presentation

1. Plan your content
2 Ask yourself:

* What is the purpose of your presentation?

* What message do you want to deliver?

B Write up the outline with all the necessary topics

204100 MS PowerPoint
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Steps to Create a Presentation

2. Add details to all topics
®  Add important details to all topics.
. Remove any unnecessary details
o Too much graphic/details can be distracting

o One idea per slide.

204100 MS PowerPoint 61

Steps to Create a Presentation

4. Fine Tuning
- Fonts
B Transition
o Animation

B Too much can be distracting

204100 MS PowerPoint 6

Steps to Create a Presentation

3. Support the headline with graphic evidence
B support your points with graphic evidence.
= This can include photos, images, charts and

diagrams.

204100 MS PowerPoint 62

Steps to Create a Presentation

5. Put details in the handouts

B The handouts should have the necessary details

not included in the slides

= PowerPoint supports printing in different formats

e.g. note pages, handouts

204100 MS PowerPoint 64
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Making Presentation Facts about Cats
*Topic: Facts about Cat ¢ Scientific Name: felis catus
¢Length: 1 page ¢ Cats are carnivorous

®Young cats are called kitten

®Rub cat’s belly at your own risk!

204100 MS PowerPoint 65 66

-

Facts abaiCats <#fith Pictures!

¢ Scientific Na

~ Scientific Name

carnivc

* Cats are carnivo

ung cats are calle

17
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